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Overview of the Q-Box CO650 Enhanced Plant CO2 Analysis Package: 

The Q-Box CO650 Enhanced Plant CO2 Analysis Package may be used to measure photosynthesis, 
respiration and photorespiration in a detached leaf (or in a leaf attached to the plant) sealed in a flow-
through chamber connected to an open flow gas exchange system. 

The Q-Box CO650 uses an infrared CO2 gas analyzer (Q-S151) to measure alternately (by using a pair of 3-
way solenoids), the concentration of CO2 in a carrier gas entering the leaf chamber as well as the 
concentration of CO2 in the gas after it leaves the chamber. The difference between incurrent and 
excurrent CO2 concentration (differential CO2) in addition to the flow of gas through the chamber, allow 
calculation of photosynthetic CO2 fixation rate (i.e. Assimilation, A).  The Q-Box CO650 can also be used 
to measure CO2 evolution from the leaf in the dark (dark respiration) or in the light (photorespiration). 

The Q-Box CO650 includes a Humidity/Temperature sensor (Q-S161) which alternately measures relative 
humidity (RH) of the air before and after it has passed through the leaf chamber. With measurements of 
the temperature of the air at the RH sensor the RH measurements are converted to water vapour and 
from the differential between incurrent and excurrent air the gas flow through the leaf chamber, 
calculation of leaf transpiration rate (E) is possible.  

An LED Light Source (A113) supplies photosynthetically active radiation (PAR) to the leaf with minimum 
heating.  The LED light is calibrated in software for use with the Leaf chamber.  The user can manually dial 

light intensity from 0 to approximately 1200 mol photons/m2/s. 

For calculations of leaf conductance, leaf temperature measurements are required.  A leaf thermistor 
(S173) is included and inserts into the base of the leaf chamber where it can be set up to touch the bottom 
of the leaf and provide measurements of leaf temperature.    

The Q-Box CO650 also includes 2 x Q-G267 Flow Monitor/Gas Pump for supplying and setting a constant 
gas flow to the leaf chamber and the reference (background) stream.  The A381 Solenoid Assembly under 
the control of the C200 Digital Control Unit (DCU) and the software, switches between the reference and 
leaf chamber gas flow to the analyzers.  The S181 Absolute Pressure sensor provides a measure of 
atmospheric pressure and is used in the calculations of CO2 exchange rates (A during photosynthesis). 

For use of the Q-Box CO650 in the field, an optional battery pack composed of 4 lithium batteries and 
charger plus cables can be added to the package.  This battery pack provides approximately 16 hrs of 
operation of the Q-Box CO650. 

Analog signals from all of the sensors are converted to digital signals via 3 integrated C610 LabQuest Mini 
Data Interfaces (9 channels).  Data is displayed, recorded and manipulated on a PC or Macintosh computer 
using Logger Pro software (C901).  The Q-Box CO650 Enhanced package can easily be adapted for 
measurements of Soil Respiration when used with a soil chamber. 
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Components of the Q-Box CO650 Enhanced: 

• Q-S151 CO2 Analyzer (Range: 0-2000ppm) includes 2 drying columns with Drierite (blue) (Q11784) and 

CO2 scrubbing column with soda lime (white) (Q13025) 

• Q-S161 RH & Temperature Sensor 

• Q-G267 Pump/Flow Monitor (Range: 0 -1 LPM) (2x) 

• Q-A101 Laboratory Stand  

• A113 LED Light Source calibrated in software for use with G112 chamber 

• G112 Flow-Through Leaf Chamber (9cm2) 

• G122 Large Gas Bags (30L x 2) 

• S173 Leaf Chamber Thermistor 

• S181 Absolute Pressure sensor  

• A381 Solenoid Assembly for CO650 

• C200 Digital Control Unit (DCU) 

• C610 Integrated LabQuest Mini Data Acquisition Interface (3 analog, 2 digital channels each) (3x) 

• C901 Logger Pro Data Acquisition Software 

• C404 Customized Setup Experimental Files 

• Q-Box Accessory Kit (includes tubing, filters, connectors, wool, small wrench for needle valve 

adjustment, screwdriver for adjustment of analyzers)  

• Q-Box Rugged Case for holding all the components 

• Instruction Manual 

• Individual power supplies for all the sensors (for use in stand-alone mode outside of the Q-Box) 

• A249-3 Battery Pack (3 Li-ion batteries with cables) (OPTIONAL) 
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Quick Start Up Steps: 

1. Load Logger Pro 3 software on the computer (follow instructions from page 25)   
2. Load C404 customized software (follow instructions from page 26) 
3. Plug the Q-Box into its power supply (or Battery Pack A249-3 for field use)  
4. Plug the A113 LED light source into its power supply (or a single Voltaic battery set to 12V for field 

use). 
5. Plug the C200 DCU into its power supply or the same single Voltaic Battery that the LED light is 

plugged into, using the two end cable, for field use) 
6. Turn on all the analyzers, sensors and flow monitors (two Q-G267, Q-S161 and Q-S151) 
7. Allow the Q-S151 CO2 analyzer to warm up for at least 15 min. A longer time (1-2 hours is 

recommended if the CO2 analyzer power has been off for a while. 
8. Open the “Q-Box CO650 Setup” file to start Logger Pro software 
9. Connect three USB cables from the Q-BOX frame to the computer  Ensure that USB1 is plugged 

in first, USB2 is second and USB3 is last. This ensures the interfaces are recognized in the correct 
order and sensors are assigned to the proper channels on the interfaces.  Once the interfaces 
are connected the senor confirmation window will appear: 

 

 

10. Assign the sensors to appropriate channels on the 3 LabQuest Mini interfaces as follows: 
a. Ch. 1 LabQuest Mini 1 = Q-S151 CO2 Analyzer 
b. Ch. 2 LabQuest Mini 1 = Q-S161 Humidity 
c. Ch. 3 LabQuest Mini 1 = Q-S161 Temperature (V) 
d. Ch. 1 LabQuest Mini 2 = Raw Voltage - A113 LED Light 
e. Ch. 2 LabQuest Mini 2 = Q-G267(1) Pump/Flow Monitor 
f. Ch. 3 LabQuest Mini 2 = S173 leaf Thermistor (C) (autodetected) 
g. Ch. 1 LabQuest Mini 3 = Q-G267(2) Pump/Flow Monitor 



6 
 

h. Ch. 2 LabQuest Mini 3 = S181 Absolute Pressure 
i. Dig.1 LabQuest Mini 3 = DCU 

The sensor configuration is shown in a text box in the Q-Box CO650 Setup file at the 
bottom of Page 1 in Logger Pro Software as shown below.   

 

11. Check the plumbing of the system by removing the tray with all the sensors from the Q-Box and 
placing it outside of the box with the back of the sensors facing up.   The system should be 
configured for calibration before it is used in experiments. 

 

 

Blue particulate 

filters 
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Component Set-Up  

Note: heavy black lines indicate gas flow; thin coloured lines indicate electrical connections 

 

 

 

 

 

 

 

 

 

 

12. Remove the Lab stand (Q-A101) from the back of the Q-Box and set it up either in stand-alone 
mode or attached to the side of the Q-Box. 
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13.  Place the Flow through Leaf Chamber (G112) on the lab stand. Note that the chamber is 
composed of two parts that are held together by 3 plastic nuts.  These have to be loosened to 
open the chamber and place the leaf in the center.  When the leaf fills the whole chamber the 
area of the leaf that is exposed to the light and may be used in all the calculations is 9cm2. 

14. Insert the S173 Leaf Thermistor in the bottom portion of the leaf chamber and tighten the sealing 
nut as shown below. When touching a leaf, the thermister will measure leaf temperature.  When 
pulled away from the leaf, the thermister will measure the air temperature in the chamber. 
Tighten the 3 plastic nuts to squash the black sealing foam to seal the leaf chamber so air will flow 
through the empty chamber. Flow through can be assured by temporarily attaching the output 
tubing to one of the Q-G267 Pump/Flow Monitors or to a rotameter if available. 

  

 

 

15. Place the A113 LED light source on the Velcro strips on top of the leaf chamber. Plug in the A113  
power supply to AC power or 3rd battery provided with the battery pack (field use). 
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Each LED light source is factory calibrated for use with the G112 Flow through leaf chamber.  

The calibration is linear, and the “custom” slope and intercept of the calibration are shown on 

the side of the LED light source (see photo below). 

 

Before using the LED light source, ensure these calibration coefficients have been entered in the 

factory into experimental file (Q-Box CO650 Setup).  To do this, open the experimental file and 

select from the top menu Experiment>Calibrate>Raw Voltage (0-5V).  Select Equation and the 

following window will appear: 



10 
 

 

16. Ensure that the correct intercept and slope for the specific A113 LED in this CO650 package are 

entered in this window.  If not, enter the new calibration parameters (from A113 label) and click 

“Apply”.  Ensure the current calibration is stored in the experiment file when saved, by selecting 

"Calibration Storage" from the same window and selecting "Experiment File" as the storage 

location. 

 

 

Save the experiment file if the A113 slope and offset were changed, so that the A113 LED 

calibration is saved with the file.  Click “Done”.  Using the A113 LED allows the user to dial exact 

levels of PAR without the need for a light meter. Note the calibration coefficients provided for 

each LED light source are specific for that LED and for use with the flow thorough leaf chamber 

(G112) only.  Different coefficients are needed for different types of chamber. 
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a. Attach the gas supply tubing (with blue filter and “Y”) from the gas bag (gas source) to the 
“in” ports on the Q-G267(1) and Q-G267(2) Pump/Flow Monitors. 

b. Attach the “out” port of the Q-G267(1) to “in” ports of the G112 leaf chamber via the 
tubing with a “Y” for sample gas measurements.   

c. Attach the “out” ports of the leaf chamber to the port labelled “chamber” on the A381 
Solenoid Assembly using the “out” tubing with a “Y”.  

d. Attach the “out” port of the Q-G267(2) to the port labelled “reference” on the A381 
Solenoid Assembly. 

e. Attach the tubing labelled “analyzers” from the A381 Solenoid Assembly to the “in” port 
on the “Q-G261” RH/Temp analyzer. 

f. Attach the “out” port of the RH/Temp sensor, to the drying column, a blue filter and the 
Q-S151 CO2 analyzer “in” port. 

g.  Gas will vent from the CO2 analyzer via the “out” port to the atmosphere.   

 

 

17. Set the same flow rate through both Q-G267 Pump/Flow Monitors.  It is recommended that 
the system be calibrated at the same flow rate as that used in experimental measurements.  
The flow through the Q-S151 CO2 analyzer should not exceed 650 ml/min. The “input” needle 
valves of the gas pumps and the speed of the gas pumps are set in the factory and should not 
be adjusted when the Q-G267 Pump/Flow Monitor is used with the Q-Box CO650 system.  
Adjust the flow through each Q-G267 with its “output” needle valve (on the back panel).  First, 
loosen the locking nut with the small 8mm wrench provided in the accessory pack and fully 
close the output valve (clock-wise) to observe a 0 L/min flow in the Logger Pro software 
(meters  in bottom left hand side of Page 1 of the Q-Box CO650 Setup file, Q-G267 Flow1 and 
Q-G267 Flow2). Adjust the “Flow Zero” potentiometer if necessary, with the small screwdriver 
supplied in the accessory kit. DO NOT ADJUST THE “FLOW SPAN”. Next slowly open the valve 
(counter-clockwise) until the desired flow is achieved.  The recommended flow is 100 ml/min.  
This may be adjusted according to the measured CO2 differential, since this differential signal 
varies inversely with the flow of gas in open flow systems such as the Q-Box CO650.  Once the 
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flow is adjusted to the desired rate, use the wrench to lock the valve in place on each Flow 
Monitor (Q-G267). This will avoid accidental changes in the flow during experiments.  Note 
that both flows are recorded in software but only the flow from Q-G267(1) through the leaf 
chamber is used in calculations for CO2 Assimilation rate (A).   

The tray holding all the sensors can then be placed back in the Q-Box. 

 

18. The Q-G267 Pump/Flow Monitors, Q-S161 RH/Temp and A113 LED light source are factory 
calibrated and should not be adjusted, with the exception of the Q-G267 zero flow as described 
above.  However, the Q-S151 CO2 Analyzer should be calibrated at the start of each day of 
experiments.   

 

19. The A381 Solenoid Assembly consists of two electronic 3-way valves which allow for switching 

between the reference gas and sample gas going through the analyzers.  These valves are 

operated by the Digital Control Unit (DCU, C200) commanded in the software. The source gas is 

continuously flowing through the leaf chamber and through the reference stream, and the 

solenoids switch which gas is delivered to the Q-S161 RH/Temp sensor and Q-S151 CO2 analyzer 

for measurements.  

 

20. When the LED light is turned on and photosynthesis is activated, the CO2 will decrease (due to 

CO2 fixation during photosynthesis) and RH will increase (due to water loss during transpiration). 

These changes are measured, and differential CO2 and RH are calculated on the run by the 

software.  

 

Locking ring 
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21.  Calibration of the Q-S151 CO2 analyzer (two-point calibration): 

The Q-S151 CO2 Analyzer has been factory calibrated but regular daily checks and adjustments are 
recommended.  The calibration is linear therefore 2-point calibration check is sufficient. These two 
points should be zero CO2 and a known CO2 standard in the range of 0-2000ppm, ideally near the top 
of the concentration range at which the analyzer will be used. The steps to follow are: 

a. Set the CO2 analyzer in the 0 – 2000 ppm range.  This is the default range upon powering 
up the Q-S151.  

b. Supply CO2-free air to the analyzer by attaching the soda lime column to the outlet of the 
RH sensor (room air entering both Q-G267s is suitable).  Attach the outlet of the soda lime 
column to the inlet of the drying column.  Keep the soda lime column vertical to ensure 
maximum contact of the flowing air with the soda lime particles.  The outlet of the drying 
column should already be vertically attached to the inlet of the CO2 analyzer. Soda lime 
will scrub the CO2 from the gas before it enters the CO2 analyzer and provide the zero 
reading (the first point of the calibration). N2 gas may also be used for zeroing the CO2 
sensor. 

c. When the reading on the CO2 analyzer is stable, use the small screwdriver provided in the 
accessory kit to adjust the “CO2 Zero” control on the analyzer to set the digital display 
(and CO2 meter on Page 1 in Logger Pro) to read zero CO2. 

 

d.  If the zero reading is highly out of range (by more than ~40 ppm), or if the maximum or 
minimum position of the “CO2 Zero” has been reached (i.e. turning the control has no 
effect), use the “Coarse Zero” adjustment on the back of the analyzer to bring zero within 
range.  Use the “Coarse Zero” with caution since very small adjustments result in large 
changes and there is a delay in response to changes in the “Coarse Zero”.  First adjust 
the fine zero to the middle of its range.  Do this by turning the “CO2 Zero” potentiometer 
on the front of the analyzer clockwise or counter-clockwise until it clicks at either end of 
its range. Then turn this potentiometer 12 complete turns in the opposite direction.  The 
“CO2 Zero” control is now centered since it is a 24-turn potentiometer. Next use the 
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“Coarse Zero” potentiometer to bring the reading close to Zero (using the small 
screwdriver). Lastly, use the fine “CO2 Zero” to make the final zero adjustment.   

 

e. Remove the soda lime column and attach the “in” port of both Q-G267s to a known CO2 
concentration source (e.g. a gas bag with known CO2 concentration, ideally near the 
maximum concentration to be measured). Outside air with ~400 ppm CO2 may be 
suitable, otherwise a mix of CO2 in N2 may be purchased from a gas supplier. 

f. If the Q-S151 display does not show the concentration of CO2 in the calibration gas, adjust 
the “CO2 Span” control until the correct concentration is displayed.   

g. If a significant adjustment had to be made to the “CO2 Span”, return to the zero check 
and ensure that the zero reading on the analyzer has not shifted. 

h. The CO2 analyzer is now calibrated. 

Calibration of the Q-S151 CO2 Analyzer in Logger Pro Software: 

If the CO2 reading on the analyzer LCD display does not match the CO2 meter reading on Page 1 in 
the Logger Pro experimental file (Q-Box CO650 Setup), then the analyzer must be calibrated as 
described above but with software calibration running at the same time.   

Note this should only be done when the CO2 analyzer display is significantly different (>~5 ppm) 
from the Q-S151 readings in the software. 

Follow steps a. and b. above, where CO2-free air is supplied to the analyzer via the soda lime column.  
Next open the calibration menu in the software as follows: 

a. From the main menu in Logger Pro Software, select Experiment>Calibrate>LabQuest Mini 
1>Q-S151 CO2 Analyzer (2000ppm).  A dialog box will appear as shown below.  Select the 
calibration storage as “Experiment File” so the calibration is saved with the current file.   
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b. Proceed to “Calibrate” in the same window (see below).  Ensure that Current Calibration is 
selected as Q-S151 CO2 Analyzer 2000ppm <Experiment>.   

 

 

c. Proceed to the second point in the calibration by removing the soda lime column and 
attaching the known CO2 gas to the input of both Q-G267s as described above in step e. 

d. Once the CO2 reading is stable, adjust the “CO2 Span”, if necessary, as described above 
and enter the value under reading 2 in the software.  Then click “Keep”, and “Done” 

e. Save the experimental file under a new name.  The current calibration will be saved with 
this file. 

22. Before collecting data in the experimental file, select Experiment > Data Collection in the main 
menu.  The following dialog box will appear: 
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Input the experiment length and data sampling rate as required.  Click “Done”. 

23. Select: File> Save As to save the experiment settings under a File Name selected so that the 
original set up file ("Q-Box CO650 Setup") is not over- written. 

 

The Q-Box CO650 system is now ready for use. 

 

Logger Pro Experimental File 

The “Q-Box CO650 Setup” file in logger Pro contains four pages.  These pages can be selected in the top 
menu or from the icon bar. 
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Page 1 shows the “Raw Data” as collected in Logger Pro and calculated from voltage inputs. Data is 

displayed in real time” on Page 1, in graphs, meters and a table.  A screen capture of Page 1 is shown 

below. 

 

 

This is where one can start data collection by clicking the green button “Collect” 

 

 

Stop data collection (manually) by clicking the red button “Stop” (green turns red once data logging starts). 

Page 1 is where the user sets up the user parameters ChamberTime and BypassTime.  These parameters 

are used to adjust the duty cycle of the PWM signal which switches the 3-way solenoids to select either 

“analysis” gas from the leaf chamber or “reference” carrier gas which bypasses the chamber to be 

delivered to the analyzers. The reference measurements are interpolated to provide a background for 

calculating differential CO2 and differential RH which are required for calculations of CO2 fixation rate (CO2 

Assimilation rate) and water transpiration, respectively. This background tracking made possible by the 

switching, corrects for any background drifts in CO2 or RH mainly caused by room temperature drifts. 
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The default values of these user parameters can be changed 1) by toggling the arrows on the right or 2) 

by double clicking on the violet parameter box to open a Parameter Control window and then typing in 

the required value. 

 

 

 

Page 2 presents automatic “online” calculations of CO2 Assimilation (A), water transpiration (E) and 

other parameters, so the user can follow the progress of the experiment in “real time”.  
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The top text box on this page lists the parameters and equations used in the calculations. 
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Page 3 allows the user to manually analyze the data after completion of the experiment. The top text 

box on this page lists the parameters and formulas used in the calculations. The data can also be directly 

exported as a CSV file (File > Export As > CSV), which can then be opened in Excel for further manual 

analysis and calculations.  Manual calculations are very useful for teaching or for checking the automatic 

calculations on Page 2.  

On Page 3 the data of interest is entered into the bottom table in red columns.  These input “Raw data” 

are obtained from the graphs on Page 1 by using the various analysis tools in the Analyze menu (examine, 

tangent, statistics, integral etc.) or by selecting the appropriate icons in the top menu bar. Calculations 

are done automatically in the black columns once the input data are entered.  

Data of interest on Page 1 can be identified by selecting all the graphs first while holding the shift key.  

Then with the mouse, select the stable region of data on one of the graphs (e.g. Q-S151 CO2 “analysis” 

values during a “chamber” time in the first light period).  While still holding the shift key, highlight (i.e. 

sweep over) the portion of interest on that graph.  Note that data on the other selected graphs for that 

time period will also be highlighted.  When the data has been selected on all the graphs, the appropriate 

analysis tool (e.g. "statistics" function) can be chosen while still holding the shift key.  The statistics 

(including a mean) will then be shown in a separate window for the selected data on each of the graphs.  

It is the mean value for each parameter that should be entered in the red columns of the table on Page 3 

of the experimental file. 
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Page 4 is an “optional” page which may be used to obtain automatic CO2 Assimilation (A) plots versus 

light (A113) or versus internal CO2 concentration (Ci) inside the leaf. Specific protocols need to be 

followed, whereby measurements are made at changing light levels or changing CO2 levels. 

 

This page includes an alarm that may be activated to remind the user to manually change, either 

the LED light levels or the CO2 concentration, depending on which experiment is being performed.  

This activation process is explained by the text box on Page 4 of the experimental file. 

 

Calculations in Logger Pro 

Below are data from an experiment with an attached houseplant leaf (acclimated to a bright LED light 

source) using outside air (~400 ppm CO2) as a carrier gas flowing at 100 ml/min in both the sample line 

(Q-G267(1)) and the reference line (Q-G267(2)). The ChamberTime and ByPassTime were both set to 3 

minutes. Photosynthesis was activated from 0 to 50 minutes with A113 LED PAR light at 200 µmol 

quanta/m2/s. The difCO2 graph between 30 and 50 min shows negative differentials when CO2 is being 

fixed (i.e. during photosynthesis). When the light is turned off at 50 min, the CO2 differentials immediately 

become positive indicating CO2 is now being produced during a rapid switch from photosynthesis to dark 

respiration. The difRH however shows a slow decrease, indicating slow closure of the leaf stomata when 

the light is turned off. 
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Page 2 is the “Automatic Calculation” page, where gas exchange parameters are automatically calculated 

during the experiment. A time plot of CO2 Assimilation (A) and water Transpiration (E) is shown on Page 2 

for the above experiment. 
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Page 4 is an optional page for the researcher who wishes to study relationship between A and Light (light 

saturation curve) or A and internal leaf CO2 levels (A/Ci) curves. Discussion of these curves can be found 

in Von Caemmerer,  S. (2000): Biochemical Models of Leaf Photosynthesis. Vol. 2, CSIRO Publishing. 

Collingwood, Australia.  The user needs to set up the experiments where CO2 assimilation (A) is measured 

at various light levels or various CO2 levels.  Both a visual and audible alert has been set up in the software 

for manually changing light level or CO2 levels by the user during such experiments.  It is included in the 

software as explained by the text box on Page 4.  This alarm needs to be first enabled by the user and 

when activated the PWM box will turn red and a short audible warning will sound during alarm activation.  

The user can then make a change in light or in CO2 levels for the next measurement. 

 

Typical data is shown below for a detached leaf grown outside (acclimated to full sunlight) and placed 

with its stem in water to prevent wilting. The carrier gas was outside air flowing at 125 ml/min and A113 

(PAR) light level was changed every 5 min (ChamberTime=3 min, BypassTime=2 min) as the 3-way 

solenoids switched from bypass to flushing the leaf chamber (i.e. PWM had a downward transition from 

1 to 0). The time plot of the light (from Page 1) as well as the A vs light graph (from Page 4) is shown below.  
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An experiment on a similar detached leaf kept in water was performed where the CO2 concentration in 

the carrier gas was varied by mixing 20.7% CO2 (balance N2) with scrubbed (i.e. 0 ppm CO2) outside air 

using two mass flow controllers (contact Qubit System for information on gas mixing equipment). The 

CO2 concentration was varied from 0 to 750 ppm. The CO2 –time plot from Page 1 is shown below. 

 

The resulting A vs Ci plot from Page 4 is also shown below. 
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Installing and Running Logger Pro 3 

 
PC Users: 
 

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer.  Before starting the 
installation, ensure that all USB cables are disconnected from the computer.  Failure to do so may 
cause an error in the installation of the USB drivers. 

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 
installed in C:/Program Files/Vernier Software/Logger Pro 3. 

(3) The setup process will automatically load the USB drivers for connecting the LabQuest mini or other 
interfaces to your computer. 

(4) If QuickTime 6 (or greater) is not installed on your computer, install it when prompted.  QuickTime 
will allow the picture and movie features of Logger Pro 3. 

(5) You will be prompted to connect the LabQuest mini or other interfaces to the computer via the USB 
connection. The LabQuest minis can be connected to the system by plugging the three USB 
connections from the Q-Box frame to the computer in order of 1-3.   

(6) Click ‘Finish’ to complete the installation process. 

(7) Proceed to C404 installation (below) before opening the Logger Pro with the “Q-Box CO650 Setup” 
file. 

(8) Double click the “Q-Box CO650 Setup” file (shortcut on the desktop from the C404 disk) to start 
Logger Pro and data collection. If Logger Pro detects the 3 LabQuest Mini interfaces, the Logger Pro 
screen will appear with three stars in the top left side 
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(9) If Logger Pro cannot detect the LabQuest Mini Interfaces, a message will appear “no device 
connected”.  Check that the LabQuest Minis are connected to the computer and that the LED power 
lights on the minis are green.  No LED light indicates that power is not being supplied to the minis.  
Check USB connections between the interfaces and the computer.  In this case, exit the “Q-Box 
CO650 Setup” file and unplug the USB cables that come from USB 1, 2 and 3 plugs on the frame of 
the Q-box.  Plug the USB cables back in with USB1 first, USB2 second and USB3 third.  This order is 
important as the computer will assign LabQuest minis as 1, 2 and 3 according to the order in which 
they were plugged in. Allow the computer to apply the drivers for the minis and re-open the “Q-
Box CO650 Setup” file again. 

 

 
  

 

Macintosh Users: 

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer (use at least OS 9.2).  
Run the “Complete Installation” and ensure that all TI GRAPH_LINK and USB cables are 
disconnected. The most recent version of Logger Pro (3) is included with this package. Following 
instructions are the same as for PC users. 

 

C404 Custom Setup Files Installation: 
 

Qubit Systems’ C404 Custom Setup Files CD contains the experimental file for this package “Q-Box 

CO650 Setup” as well as the manuals for the package and the operation of the LabQuest Mini data 

interface.  These files can be copied to a user specified location on the computer and the experimental 

file of interest “Q-Box-CO650 Setup” should be placed in an accessible location or have a shortcut to the 

file created on the desktop.  Make a copy of the original file and keep it in a safe place on the computer 

in case the original is accidentally altered. 
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Using the Q-S151 CO2 Analyzer  

The Q-S151 CO2 Analyzer is a non-dispersive infrared gas analyzer (IRGA).  It has a gas input port with a 
female luer-lock connector and a gas out port with a male luer-lock connector. Bev-a-lineTM tubing with 
luer-lock connectors is provided, to connect the components of the gas exchange system.  Bev-a-line has 
very low water absorption (for RH measurements) and very low permeability for (CO2 measurements). 
The gas supplied to the IRGA passes through a wave guide and vents from the exit port.  The Q-S151 can 
be used as a stand-alone analyzer in an open or closed-circuit gas exchange system. It can be used with 
other gas analyzers downstream.  However, ensure that the placement of an analyzer downstream from 
the Q-S151 does not cause a significant increase in backpressure.  Increasing pressure significantly beyond 
that at which the IRGA was calibrated, produces erroneously high readings. 
 

The maximum flow of gas into the Q-S151 should not exceed 650 mL/min. The flow is provided and 

monitored by the two Q-G267 Pump/Flow Monitors.  It is controlled by the outlet control valve on the Q-

G267. The Q-S151 should be calibrated at the flow rate used during the experiments. 

Gases entering the Q-S151 must be clean and dry, since particulate matter may absorb infrared light and 

cause erroneous readings.  Water vapour will not interfere with the absorption measurement of CO2, but 

water vapour will dilute the CO2 slightly. The Q-S151 CO2 analyzer is supplied with a drying column 

containing DRIERITE.  This drying agent very removes moisture from the analysis gas before it enters the 

CO2 analyzer.  Poly wool plugs at the base and top of the drying column are needed to filter particulate 

matter. A blue particulate filter (25m) should also be used after the drying column before the CO2 

analyzer so the gas entering the Q-S151 is clean.  

The Q-S151 CO2 Analyzer requires 12 Volts DC power to operate. A 120/220 AC power adaptor (included) 

provides 12 Volts DC.  For continuous use, leave the AC adapter plugged into an AC power outlet. 

 

Caution:  Use only a 12 VDC adapter with the correct AC line voltages.  A 120/220 VAC 50/60 Hz 

to 12 VDC adapter is supplied by QUBIT SYSTEMS FOR STAND ALONE USE.   

 

The unit requires a 2 to 3-minute warm-up period before the CO2 level will be displayed.  During warm-

up, the LCD will flash numbers briefly and display the number 1.  After the unit has warmed up, the LCD 

will display a very high reading, which will slowly decline to the CO2 level in the gas stream that is provided 

to it.  

For most accurate and stable readings, the Q-S151 should be warmed for minimum of 15 min to 1 hour 

before use and if the unit was off for a while 1-2 hours is recommended.  If the Q-S151 is to be used on a 

regular basis, it should be powered continuously to maintain a stable signal. 
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Altitude and Barometric Pressure Correction 
 

The Q-S151 is factory calibrated at sea level.  When using the IRGA at elevations other than sea level, 

calibrate at the elevation at which the analyzer will be used since the analyzer measures the partial 

pressure of CO2 in the air.  If this is not possible, correct the CO2 reading of the analyzer according to the 

table below.  For example, when using a factory-calibrated unit at an altitude of 2,500 feet, multiply the 

displayed CO2 reading by 89% (1,000 ppm x 0.89 = 890 ppm actual).   

 

Altitude 

(feet) 

Pressure 

(inches Hg) 

Pressure 

(mm Hg) 

Pressure 

(psia) 

% Display 

Reading 

0 sea level 29.92 759.78 14.70 100 

500 29.38 746.04 14.43 97.97 

1000 28.86 732.84 14.18 95.94 

1500 28.34 719.64 13.92 93.91 

2000 27.82 706.43 13.66 91.88 

2500 27.32 693.73 13.42 89.84 

3000 26.82 681.04 13.17 87.81 

3500 26.32 668.34 12.93 85.78 

4000 25.82 655.65 12.68 83.75 

4500 25.36 643.96 12.46 81.72 

5000 24.90 632.28 12.23 79.69 

 

For other altitudes, use the following equation: 

Percentage of measured CO2 = [1- (4.06234 x 10-5 x Altitude in feet)] x 100 
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The Drying Column and Soda Lime Column 

The Q-S151 is designed to analyze dry gas samples.  A desiccant column is provided which is filled with 

DRIERITE to dry the gas before analysis.  The column is supplied ready for use.  The column should be 

mounted vertically on the back of the Q-S151 during use of the analyzer to ensure maximum contact of 

the flowing gas with the Drierite particles. 

DRIERITE contains a cobalt indicator that is blue when the column is functional and pink when the 

DRIERITE is spent.  When spent, the DRIERITE should be replaced or reconditioned.  To recondition, 

remove the DRIERITE from the column and place it in a drying oven at 210oC for 1 hour, or until the pink 

coloration disappears.  The replacement DRIERITE is #8 mesh, order #23005 from drierite.com.  

Note: Drierite may affect CO2 response time due to slight absorption and release of CO2.  

Magnesium Perchlorate is an alternative drying agent which does not affect CO2 response time.   However, 

magnesium perchlorate will harden and impede the gas flow when it absorbs significant water vapour. 

Eventually with too much moisture, it may liquefy, so it must be changed frequently.  It is recommended 

that a trap is installed downstream if using magnesium perchlorate.  Qubit Systems is not responsible for 

any damage caused to any components of the Q-Box CO650 due to magnesium perchlorate entering 

any part of the system. 

Warning: Magnesium perchlorate can cause respiratory tract irritation.  Users should read and comply 

with a Material Safety Data Sheet on magnesium perchlorate. 

The Q-S151 CO2 analyzer is provided with a CO2 scrubbing column filled with soda lime (white column).  

Soda lime is used to provide CO2-free gas for zeroing during calibration.  This can be done by pumping air 

through the column and to the CO2 analyzer.  A small amount of glass wool should be placed towards the 

outlet of the column, and the column should then be filled with soda lime using a spatula.  When the 

column is full, it should be tapped on a solid surface to settle the soda lime, and then it should be topped 

off.   The soda lime column should be used in a VERTICAL position for maximum contact with the flowing 

gas. 

The soda lime provided with the Q-S151 has a coloured indicator to show when it is spent.  The soda lime 

should be replaced when most of it has changed from its original white colour to a pale purple.  This colour 

change is subtle, and the purple coloration often does not persist, but appears as a band in the column at 

the junction between active and inactive soda lime.  Replacement supplies may be obtained from Fisher 

Scientific (product #S200I-3).  It should be removed from the system during measurements of CO2 and the 

two ends should be reattached to keep the column closed to prevent depletion of the CO2 scrubbing 

chemical. Soda lime cannot be regenerated once spent. 

Note: remove the soda lime column from the system once calibration has been completed. 

Warning: Soda lime can cause severe burns.  Users should read and comply with the Material Safety 

Data Sheet on soda lime. 
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Troubleshooting the Q-S151: 

 

Span or zero out of range may cause “1” to appear on the display: 

Turn the “CO2 Span” all the way down (counterclockwise) and use the “Coarse Zero” on the back of the 

CO2 analyzer to display 0 with zero CO2 gas running through the system.  Once zero display is achieved, 

attach a known CO2 concentration to the system. Use the “CO2 Span” to adjust the display on the CO2 

analyzer to the correct CO2 concentration reading.  Return to the zero CO2 check with zero CO2 gas running 

through the system. If necessary, make small adjustments with the “CO2 Zero”. 

Ensure no material (liquid or dust) has entered the analyzer: 

If material has entered the analyzer, it will block the internal light path and “1” will be shown on the 

display.  The unit will need to be returned to QUBIT Systems for repair. 

Ensure the Gas Flow Path in the Analyzer is Open: 

Check that there are no internal leaks in the analyzer.  Connect a 10mL syringe to a tube connected to the 

‘OUT Port’ of the CO2 analyzer and plug the ‘IN Port’.  Pull a slight vacuum with the syringe.  You should 

feel a trapped negative pressure that does not change.  If there is an internal leak, contact QUBIT Systems 

for further instructions. If the analyzer is exposed to extreme pressures, a leak can result. 

Ensure you are using the Soda Lime CO2 Scrubbing Column to provide Zero CO2 gas to the analyzer. 

Do not confuse the soda lime column with the drying column filled with Drierite.  Soda Lime is white.  

Drierite is blue and turns pink when it is spent.    If unsure of the condition of the Soda Lime in the column, 

replace it with new Soda Lime. Alternatively, use a gas with zero CO2, such as pure N2. 

The CO2 readings on the display of Q-S151 are different from those in Logger Pro 

If the CO2 values displayed on the Q-S151 CO2 Analyzer are very different (>~5 ppm) from those displayed 

in the Logger Pro file check the following:  Ensure the correct range is selected on the CO2 analyzer (2000 

ppm is the default upon power-up; use this range with the Q-Box CO650 package) and the ensure same 

range is selected in the software (Q-S151 CO2 Analyzer (2000ppm)). If the range was selected correctly, 

check that the LabQuest Mini interfaces have not been assigned incorrectly. Check that values displayed 

in Logger Pro software for other sensors are correct. For example, turn on the LED light source and check 

that values in the LED meter display in the software change as light is dialed up and down.  If the LabQuest 

Minis have not been mixed, then the CO2 Analyzer requires new calibration in the software.  Proceed with 

the calibration instructions outlined above on page 14.   If the LabQuest Minis have been mixed (for 

example: when the LED light is turned on, the Q-S151 readings change), follow the instructions below on 

page 36 to fix the problem. 
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Specifications of Q-S151: 

• Operating principle  - Non-dispersive infrared 
• Gas sampling mode - Flowing gas stream, sealed chamber 
• Maximum gas flow rate - 650 mL/min 
• Measurement range (LCD display)-  0 – 1999 ppm 
• Analog output, low sensitivity- 0 – 2000 ppm 
• Analog output, high sensitivity- 0 – 500 ppm 
• Resolution -  ± 1 ppm 
• Repeatability (at stable atm press and temp)- Better than ±1 ppm 
• Response time (@ 250 mL/min; to 95% of final value) - ca. 25 sec 
• Warm up time (@ 22oC) – ca. 5 min 
• Output (linear) for Low Sensitivity setting – 0 – 5 VDC for 0 – 2000 ppm 
• Output (linear) for High Sensitivity setting – 0 – 5 VDC for 0 – 500 ppm 
• Calibration adjustments – Zero and Span 
• Operating temperature range –  0 to 50oC 
• Storage temperature range  -  -40 to 70oC 
• Operating pressure range - ±1.5% local mean pressure 
• Humidity range -  5 to 95% RH, non-condensing (recommend drying gas stream) 
• Pressure dependence – +0.19% reading per mm Hg 
• Power requirements-  12 VDC via 120 VAC/60 Hz adapter 
• Current requirements – 125 mA average, 450 mA peak 
• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17) 
• Weight - 1kg 
• Warranty - 1 year limited 

 

Using Q-S161 RH/Temperature Sensor 

The Q-S161 has been factory calibrated and should not require additional spanning.  However, if with time 

the values of RH become erroneous the zero may have drifted.  To reset the zero, flow dry gas through 

the sensor (running through Drierite) and with “RH Zero” adjust the output until it reads 0 in the Logger 

Pro software.  Be cautious not to accidently adjust the “RH Span”.  If “RH Span” is accidently adjusted, 

the instrument will need to be recalibrated with a gas of known RH.   
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Using Q-G267 Pump/Flow Monitors 

The Q-G267 Pump/Flow Monitor contains a 1L/min (no load) gas pump.  Two Q-G267 are used in this 

package.  Q-G267(1) is used to deliver gas to the leaf chamber and Q-G267(2) is used to deliver 

reference gas (bypassing leaf chamber) to the analyzers.   Both Q-G267 Pump/Flow Monitors are 

delivered with pre-set pump speed and input control valve. The flow rate should be adjusted only with 

the output needle valve of the Q-G267.  
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The flow rate of both Q-G267 should be set to similar levels when used with the Q-Box CO650 package 

so the same flow is used for reference and analysis gas streams. 

If the Q-G267 Pump/Flow Monitor is used in a stand-alone mode and the flow needs to be adjusted, it 

can be done with the two needle valves on the back.  To set the flow, initially fully open both needle 

valves on the back of the Q-G267 (turn counter-clockwise). Adjust the flow rate down to about twice the 

required rate using the “inlet” valve.  Second reduce the flow further to the required rate with the 

“outlet” needle valve (see photo below).   

 

 

 

 

 

Turn the valves clockwise to reduce the flow or counter clockwise to increase the flow.  Once the flow is 

adjusted, use the small wrench provided in the accessory pack to lock both valves in place to avoid 

accidental changes in the flow rate during experiments. 

 

Locking ring 
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A113 LED light Source 

The LED light source provides light to the leaf with minimal heating.  It is constructed of a group of 9 cold 

white LEDs that are arranged in a support that sits directly on top of the leaf chamber. The A113 

provides a maximum irradiance of about 1200 µmol quanta/m2/s of photosynthetically active radiation 

(PAR) at the leaf surface.  The irradiance is adjusted using the potentiometer knob on the LED amplifier 

box.  An analog data cable from the light source plugs into LabQuest mini interface, and the amount of 

light supplied to the leaf is plotted directly on the computer screen when Logger Pro software is 

activated.  Readings above 20 µmol quanta/m2/s are accurate, while lower readings should be ignored.  

Each LED light source comes factory calibrated for use with the G112 flow through leaf chamber.  Hence 

a light meter is not required when using the LED light source.  The calibration coefficients (shown in the 

label on the LED light source) are factory-entered in the Q-Box Setup file. This can be verified as 

described above (page 9, 10). 

 

 

 

G122 Large Gas Bags 

Two large (30L) gas bags are supplied with the Q-Box CO650 package.  The gas bags are made from a 

gas-impermeable nylon-polyethylene laminate and are heat-sealed.  Tygon tubing is attached to each 

bag by a luer-lock fitting.  The fitting on the other end of the tubing attaches directly to the fittings on 

the Q-G267 Pump/Flow Monitor inlet port.  These bags can be filled with air to provide a constant 

source of CO2 or another gas mixture (various CO2 concentrations) as required by the experiments.  Bags 

should not be over-inflated, as this can cause weakening of the seams and eventual leakage.  After use, 

the bags should be fully deflated, preferably by attachment to a vacuum-line.    
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A249 Battery Pack (optional) 

 

The A249 battery pack is composed of two Voltaic V88 Universal Batteries.  The Q-Box CO650 has an 

additional battery for operation of the LED light source and the DCU unit when used in the field conditions.  

The batteries are Lithium Polymer and can be charged directly via an AC charger or from a car battery via 

a DC charger (included).   The two batteries that power the Q-Box supply a maximum of 177 Watt hours 

of power.  Both batteries together or one at a time are hooked up to the Q-Box power outlet via the split 

cable provided.  The use of A249 Battery Pack allows field operation of the Q-Box CO650 or any other Q-

Box package for up to 11hr (without the lap top computer).  Each voltaic battery has one “Out” port for 

plugging in the Q-Box power cable and an “In” port for plugging in the AC or DC charging adaptor. The 

Voltage output from the battery to the Q-Box has to be set to 12V. This is selected by pressing the black 

button on the top of the batter for 3 sec and then again for selection of 12V.  It is important to set up 12V 

output before the battery pack cable is plugged into the Q-Box.  Settings higher than 12V may damage 

the Q-Box. 

Once the battery pack is connected to the Q-Box the output voltage cannot be accidently changed. 
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The placement of the batteries in the Q-box is shown in the photo below.  The third battery for the 

operation of the A113 LED light source can be placed behind the sensors as shown in the photo below. 

 

A small padded pouch is provided for storage and transport of the 3rd battery that is used with the LED 

light source and the DCU (via a split cable).  This pouch can be placed on top of the sensors inside the Q-

box during storage or transport of the Q-Box. 

 

 

 

Input from charger 

Output to Q-Box via 

battery power cable 

 

 Select 12V (press 

down for 3 sec 

until selection is 

flashing press again 

to change voltage 

selection to 12V 
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Troubleshooting LabQuest Minis 

LabQuest Mini 1, 2 and 3 are switched 

If the sensors show unusual values (for example, turning on the A113 LED light source changes the Q-S151 

readings in software) the Logger Pro software may have confused the order of the LabQuest Minis.  To 

rectify this problem, follow these steps: 

Close the “Q-Box CO650 Setup” file.  Unplug the three USB cables from the frame of the Q-Box.   

 

Open the “Q-Box CO650 Setup” file first.  Then plug the first cable back into the USB 1 outlet on the frame, 

then plug the second cable into the USB 2 outlet and finally plug in USB3 (in that order).  As each LabQuest 

Mini is recognized by the computer drivers, the indicator LED light on the appropriate LabQuest mini will 

change from red to orange to green and a star will appear in the software in the top left side of the menu.  

The sensor connection window will also appear, and all the sensors should be connected to appropriate 

channels on the 3 LabQuest Mini interfaces as follows: Note that the leaf thermister will be autodetected 

on channel 3 Mini 2. 
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S181 Absolute Pressure Sensor 

The Q-Box CO650 enhanced package includes the S181 absolute pressure sensor.  This sensor 

measures atmospheric pressure (Patm) during experiments.  This parameter is used in 

calculations of molecular flow, saturated water vapour concentration and transpiration rate.  The 

S181 absolute pressure sensor is a silicon-based electronic sensor. It measures changes in 

pressure and produces a voltage output in the range of 0-2V that corresponds to pressures of 15-

115 kPa.  This sensor is factory calibrated and only needs to be plugged into the LabQuest Mini 

interface.  The sensor is temperature-compensated and has a fast response time (1ms).  Do not 

submerge the sensor under water. It is designed for measurements of atmospheric pressure 

only. 
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The S181 pressure sensor require a power supply to use and data interface with software.  When used 

with the Q-Box CO650 the sensor is plugged into the Q-Box frame and draws its power via Q-Box main 

power supply.   

C200 Digital Control Unit (DCU) and the A381 Solenoid Assembly 

The Digital Control Unit (DCU) works to control the switching of the two-solenoid valve 

assembly (A381) and delivery of either reference or sample gas to the analyzers.  Ensure that 

the solenoid valve assembly cable is connected to D1 plug on the DCU and the BTA data cable 

from the DCU is connected to Digi 1 on LabQuest Mini 3 data interface.  The DCU unit has its 

own power supply for connection to AC power plug.  When used in the field with a battery pack 

it should be connected via double cable to the third battery, together with the A113 LED light. 
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The solenoid Assembly should have gas input from the reference stream (Q-G267(2)) and from the leaf 

chamber connected to the tubing labeled as such.  The tubing labeled “Analyzer” should be connected 

to the gas “in” port on the Q-S161 RH/Temp sensor. 
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Qubit Systems Warranty Information 

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 

one year from the date of invoice/shipment from QUBIT.  

If at any time within this warranty period the instrument does not function as warranted, return it and 

QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance charges 

(for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return of the 

instrument to the customer.     

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 

unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 

adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.   

The warranty is return-to-base only, and does not include on-site repair charges such as labor, travel, or 

other expenses associated with the repair or installation of replacement parts at the customer’s site.  

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.  

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.  

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 

is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 

charged as such.  

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-on-

delivery basis.   

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 

naturally and inevitably occurs as a result of normal use or aging even when an item is used competently 

and with care and proper maintenance. 

Return Procedure 

Before returning any instrument to QUBIT:   

Please consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and 

has not just been set up improperly.  

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 

instructions.   QUBIT will refuse any goods that are returned without an RMA number or which are sent 

in a manner outside of QUBIT’S  stipulations. 
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If you have encountered a program failure, we would need a printed copy of any faults you have seen, 

including how to reproduce them.  Include these in the return package along with your mailing address.  

Include a copy of the Invoice on which the product was shipped to you.  

All returns must be shipped prepaid.  Unpaid packages will not be accepted.  

In case of questions contact QUBIT  

by E-mail: info@qubitsystems.com,  

by phone: (01)-613 384 1977,  

or by fax: (01)-613 384- 9118. 

 

mailto:info@qubitsystems.com

